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Jetico Product Release Notes: 
Jetico Personal Firewall v.2 

 
 
Note: This document is regularly updated and is subject to change without notice. We invite you to 
share your feedback with us, including reporting issues with our products, via our online contact 
form at www.jetico.com/contact/. 
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1. Minimum System Requirements 
 10 MB disk space  
 Installed size is 5 MB 

2. Supported Operating Systems 
 Windows 7 
 Windows Vista 
 Windows Vista x64 edition 
 Windows XP 
 Windows XP x64 edition 
 Windows 2008 Server 
 Windows 2008 Server x64 edition 
 Windows 2003 Server 
 Windows 2003 Server x64 edition 
 Windows 2000 

3. Product Updates 
16-December-2010 | v.2.1.0.10 
Hungarian Translation created by Rad Aeneas László. 
Eliminated "Could not connect to firewall server" problem after third-party program installation. 
Improved drivers' stability. 
 
01-October-2010 | v.2.1.0.9 
Added Jetico Personal Firewall self protection component. 
Improved system files protection. 
Corrected process attack module on Windows 7 and Vista systems. 
 
17-August-2010 | v.2.1.0.8 
Improved stability. 
Added additional registry checking. 
Stateful engine now fully supports TCP window scaling. 
Minor UI improvements. 
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29-December-2009 | v.2.1.0.7 
Port scan detector now works correctly with VPN connections. 
Eliminated high CPU usage on startup. 
Fixed incorrect application termination. 
Improved stability on 32-bit Windows 7. 
Language files updated. 
 
21-October-2009 | v.2.1.0.6 
Resolved problem with Windows 7 User Account Control 
Stateful engine settings can now be tuned via registry 
 
18-September-2009 | v.2.1.0.5.2385 
Stateful inspection engine improved. 
Resolved problem with IIS7 incoming connections under Vista or Server 2008. 
Process protection enabled for Windows 7. 
A table's default action restored after import or clone operations. 
Popup dialog now supports empty groups list. 
"Critical system object modification" event parameters corrected. 
Application accessibility improved. 
Romanian translation provided by Mihai Iepure. 
 
29-June-2009 | v.2.1.0.4 
Added ARP packet MAC addresses filtering 
Added Table hints for best template selection 
Added Table properties dialog 
Help file updated 
Minor issues resolved 
 
23-March-2009 | v.2.0.2.9 and v.2.1.0.2 
Pete Mierski translated language file to Polish language. 
Empty event in Application checksum rules fixed. 
Improved hash calculation. 
Documentation updated. 
JPF 2.1 beta only: UDP broadcasts support. 
JPF 2.1 beta only: resource leaks fixed. 
 
30-January-2009 | v.2.1.0.1 
JPF 2.1 beta has new stateful packet inspection module. 
New SPI module features: 
- Pass-through connections handling; 
- Improved port scan detection. 
Please note: replies to broadcast UDP packets are not recognized in JPF 2.1 beta. 
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08-December-2008 | v.2.0.2.8 
Visual Studio build process hangup fixed. 
Hash calculation problem fixed. 
Stateful ARP filtering improved. 
Process protection improved. 
Registry monitoring improved. 
New "change process privileges" process attack event introduced to control process privilege 
elevation. 
Ukrainian translation created by Xa0c. 
Language files updated. 
Configuration template updated. 
 
06-November-2008 | v.2.0.2.7 update 
Italian translation created by Keltoi and Tom. 
Japanese translation updated. 
 
03-October-2008 | v.2.0.2.7 
Setup program improved. 
Uninstall program improved. 
New "critical system object modification" process attack event introduced to control access to 
critical system configuration objects. 
System crash caused by hook detector fixed. 
 
25-August-2008 | v.2.0.2.6 
German language file created by Stefan Beinroth and Martin Zoller. 
Memory leak in bcftdi.sys fixed. 
Random crash in bcftdi.sys fixed. 
User interface adjusted for right-to-left reading order. 
Incomplete group export bug fixed. 
ARP packet parameter logging added. 
Log tab selection style restored. 
 
06-August-2008 | v.2.0.2.5 
"Add parameter to group" option added to popup dialog. 
Kernel exception on multi-core systems during fast user switch fixed. 
Setup program fixed. 
 
30-June-2008 | v.2.0.2.4 
Firewall now creates backups prior to updating configuration file. 
More accurate "indirect access to network" detection. 
"Access to network" for large .exe files fixed. 
Truncated path in "access to network" events fixed. 
Kernel exception on fast user switch fixed. 
Protocol list in low level protocol module fixed. 
 
26-May-2008 | v.2.0.2.3 
Problem with Firefox access to network fixed. 
Windows 2000 protection improved. 
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20-May-2008 | v.2.0.2.2 
Inter-process communication monitoring improved on Vista systems. 
Executable image hash is now checked on-demand for large files. 
Bug in Security Center detection on Windows XP SP3 fixed. 
Import/Export and Language menu item id collision fixed. 
Brasilian, Russian and Turkish language files updated. 
 
05-May-2008 | v.2.0.2.1 
Configuration Import/Export added. Now Jetico Personal Firewall can import/export individual 
tables or security policies. 
New process attack events added:  
- "control process" produced when an application requests access rights that will allow it to 
terminate suspend or crash another application; 
- "control system services" produced when an application requests access to Service Control 
Manager. 
By monitoring these events Jetico Personal Firewall can effectively defeat attacks modeled by kill, 
crash, suspend and system shutdown simulator tests.  
Default configuration template updated. 
System crash on logging fragmented packets fixed. 
Vista SP1 and Windows Server 2008 random crash fixed. 
Group management code improved. 
Group contents are displayed in rule parameter editors (tooltips). 
Minor group tab user interface bugs fixed. 
Table names in actions list are sorted alphabetically. 
Wrong registry key and application path report in Process attack popup dialog fixed. 
Chinese Traditional translation provided by Steven Nien. 
Turkish translation provided by Mehmet Kalyon. 
Authors updated language files to reflect the latest user interface changes. 
 
18-February-2008 | v.2.0.1.5 
Short filenames problem fixed. 
"Clone table" problem fixed. 
Dutch translation updated. 
Seamonkey detection added. 
 
01-February-2008 | v.2.0.1.4 
Port scanning problems fixed. 
Hang-up while updating DNS cache fixed. 
Hang-up after security policy switching fixed. 
Spanish translation contributed by Senpai. 
Skype detection updated. 
 
24-January-2008 | v.2.0.1.3 
System crash after group update fixed. 
Configuration Wizard UI is now correctly translated during setup. 
Dutch translation contributed by Jochem. 
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11-December-2007 | v.2.0.1.2 
Vista SP1 and Windows Server 2008 support. 
Jetico Personal Firewall v.1 hook detector added to 32-bit version. 
Sending message to another application detected. "Breakout" tests passed. 
ARP stateful filter parameters can be changed via registry now. 
Problems with network connections after installation on Vista systems fixed. 
Hook detector hang-up on SMP Vista systems fixed. 
PFN_LIST_CORRUPT blue screen on Vista systems fixed. 
Memory leak during uninstallation on Vista systems fixed. 
Stability at high load improved. 
Policy combobox behavior fixed. 
Configuration template updated. 
 
25-October-2007 | v.2.0.0.37 
Stateful ARP rule now protects from ARP DoS attack. 
Low level protocol rule can check ARP opcode, source and destination IP addresses now. 
License checking in setup program fixed. 
Policy combobox update problem fixed. 
Configuration Wizard can now detect files in %SystemRoot%\System32 directory on 64-bit 
systems. 
Default configuration template updated: Avant, Maxthon, Netscape 9, Safari browsers detected; 
Vista UAC application detected; Added Windows components that require indirect access to 
network; "Network Time Protocol client" template fixed. 
 
12-October-2007 | v.2.0.0.36 
Memory leak in bcftdi.sys driver fixed. 
Domain names are printed in configuration tables is available. 
 
20-September-2007 | v.2.0.0.35 
System crash caused by bc_tdi_f.sys driver under heavy load fixed. 
Application adding via "..."(Browse) problem in rule editor on Vista fixed. 
Firewall shutdown now allowed with expired license. 
Configuration Wizard "Next >" button behavior fixed. 
Default configuration template updates: Rule for Ximeta NDAS devices added (off by default); 
"Network Time Protocol client" application template table added; "Allow everything" application 
template table added. 
 
22-August-2007 | v.2.0.0.34 
Stateful inspection for ARP protocol added. 
Monitoring of direct access to memory, OLE/COM communications, process code/memory 
modifications disabled in 64-bit versions to prevent conflict with Kernel Patch Protection after 
Windows Update KB932596: http://support.microsoft.com/kb/932596 
Clone/Delete policy, Clone table, Expand/Collapse commands added to policy tree context menu. 
Empty values handling fixed in rule parameter editors. 
Column order save/restore bug fixed. 
French translation provided by Patrick Leloup. 
Default configuration template updates: Explorer.exe is allowed to access the network; Stateful 
ARP enabled to prevent ARP poisoning; "Bypass" rule fixed in the "Access to network" table. 
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31-May-2007 | v.2.0.0.33 
System crash on high load fixed. 
 
25-May-2007 | v.2.0.0.32 
Firewall freezing on switching security policy fixed. 
Setup program registration fixed. 
JPF server memory usage reduced. 
Russian translation updated. 
 
22-May-2007 | v.2.0.0.31 
Log subsystem performance improved. 
Log race conditions fixed. 
Commercial license expiration bug fixed. 
Opera 9.20 and Skype detection improved. 
'About' dialog text fixed. 
Traffic summary labels corrected. 
 
23-April-2007 | v.2.0.0.30 
Rule update after group values change fixed. 
Rule reordering for copy/move operations fixed. 
Application rule parameters (local port, remote address) order corrected. 
Hash parameter handling bug fixed. 
Event log messages improved. 
IP rule parameters are displayed in the 'Misc' column. 
Configuration Wizard import function fixed. 
Chinese (simplified) translation contributed by Gao Xue Feng. 
 
13-April-2007 | v.2.0.0.29 Release Candidate 
Extra memory usage issue fixed. 
JPF.exe startup problems fixed. 
Domain names added to IP addresses in Log tab and Popup dialog. 
Configuration template updated. New templates: Skype, ICQ (ICQ, ICQ Lite, Miranda, Trillian, 
Qip), IRC (mIrc, Miranda, Trillian), Windows Messenger, Windows Media Player, Direct Connect 
(DC++), BitTorrent (uTorrent) 
Language file and translations updated. 
 
9-April-2007 | v.2.0.0.28 Beta 
System crash on installing global hook fixed. 
Basic SYN flood protection added to stateful rules. 
License expiration warnings added. 
Brasilian Portuguese translation contributed by Milton Chaves de Almeida. 
Language file (langfile.txt) updated. 
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2-April-2007 | v.2.0.0.27 Beta 
"Critical registry modification" process attack event added. 
DLL injection detection code improved. 
Crash on cancelling new rule creation fixed. 
Setup program prepared for localization. 
Updated Configuration Wizard can translate configuration texts. 
Language file (langfile.txt) updated. 
Japanese translation contributed by Dobry Den:  
http://dobry-den.sakura.ne.jp/html/JPF_top.htm 
Registration dialog bugs fixed. 
 
5-March-2007 | v.2.0.0.26 Beta 
Configuration Wizard Windows 2000 compatibility problem fixed. 
Popup questions in the default configuration template updated. 
Help->About dialog now displays localization info. 
RTL languages support added. 
Language file (langfile.txt) updated. 
 
28-February-2007 | v.2.0.0.25 Beta 
System crash on launching applications from network drive fixed. 
Random system crash in bcftdi.sys fixed. 
Vista 64-bit edition login problems solved. 
System crash after firewall uninstallation on Vista 64-bit edition fixed. 
Network problems after JPF uninstallation on Vista fixed. 
Windows Media player file access problem fixed.  
Firewall hang-up on changing configuration file fixed. 
Firewall crash on adding rule with "go to table" action fixed. 
Default configuration updated to minimize amount of popups. 
 
22-February-2007 | v.2.0.0.24 Beta 
OLE/COM interprocess communications handling fixed. 
Configuration Wizard added. 
 
31-January-2007 | v.2.0.0.23 Beta 
System crash on answering popups fixed. 
Application groups editor fixed. 
 
30-January-2007 | v.2.0.0.22 Beta 
System hang-up on incoming connections fixed. 
Windows 2000 drivers compatibility issue fixed. 
Windows 2000 setup program fixed. 
Network file paths handling corrected. 
 
17-January-2007 | v.2.0.0.21 Beta 
System crash on dual-processor systems fixed. 
System folder redirector compatibility issues fixed on 64-bit systems. 
Failure on editing rules with "Inverted match" on Application parameter fixed. 
 
 
 
 



 
 
 

 

Protection made perfect.

Innopoli 2, Tekniikantie 14 
FI-02150 Espoo, Finland 
www.jetico.com 

15-December-2006 | v.2.0.0.20 Beta 
Vista systems support added. 
System crash on intensive logging fixed. 
"indirect relativeness" indirect access to network type added for complex indirect relationships like 
process_1-parent->process_2-interprocess call->process_3 
"Browse" button added to application groups editor. 
Popup dialog updated. 
Terminated process ID logging fixed. 
Firewall upgrade procedure fixed. 
 
9-November-2006 | v.2.0.0.17 Beta 
Zero applications hash fixed. 
Hang-up on playing video files (direct access to memory) fixed. 
System crash on UDP communications fixed. 
JPF network monitor driver crash fixed. 
More verbose popup questions in default configuration. 
 
2-November-2006 | v.2.0.0.16 Beta 
Crash on checking application activity fixed. 
Hang-up and configuration file corruption after multiple drag-and-drop operations fixed. 
 
27-October-2006 | v.2.0.0.15 Beta 
Windows XP 64-bit, Windows 2003 server (both 32 and 64-bit) support added. 
DNSTester test passed. 
IP CRC checking fixed (IP rules). 
Empty popup messages removed. 
Firewall access control list checking fixed. 
Buffer overflow on entering long application names fixed. 
DHCP rules added to default configuration. 
 
26-September-2006 | v.2.0.0.10 Beta 
System startup problems fixed. 
System crash on process attack rules fixed. 
Incorrect list of protocols handling fixed in IP rules. 
Rule editors design improved. 
Setup program fixed.  
Default configuration changes: jpf.exe allowed to install global hooks; Spelling errors corrected. 
Jetico Personal Firewall executable modules were signed. 
 
13-September-2006 | v.2.0.0.9 Beta 
System crash on rules with empty groups (appeared in v.2.0.0.8) fixed. 
Rule from log creation function fixed. 
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11-September-2006 | v.2.0.0.8 Beta 
Blue screen after moving disabled rule fixed. 
Multiple events checking is corrected in hash checking rule. 
Type of empty tables (network/application/...) is written to configuration file. 
Default action update after editing fixed. 
Configuration tab remembers selected table between sessions. 
Uninstall program fixed. 
"Groups" tab fixes: Warning on used groups deletion added; "Expand" context menu function 
implemented; "Create" context menu function fixed. 
"Applications" tab fixes: Header and context menu added to translatable strings; "Copy text" 
context menu function fixed. 
Options->General/Log/Access control dialogs added to translation. 
Popup dialog tooltips fixed on Windows 2000. 
 
29-August-2006 | v.2.0.0.7 Beta 
Firewall startup bugs fixed (error codes 80080005, 80070776). 
Duplicated popup messages fixed (echo popups). 
Buffer overrun on long filenames in application groups fixed. 
"direct memory access" process attack event handling fixed. 
UDP port checking bug is fixed in IP rules. 
Window position is saved on shutdown now. 
View->Toolbar status is displayed correctly. 
Default configuration file updated to allow Jetico Personal Firewall client-server communications; 
duplicated rules removed. 
 
14-August-2006 | v.2.0.0.6 Beta 
"CoCreateInstance failed. hr=0x80070005" bug fixed. 
System crash on rules with wildcards fixed. 
"Copy text" function fixed. 
Group view context menu fixed. 
"Select log file" and MRU list are removed from log view context menu. 
Default configuration file fixes: access to network is granted to csrss.exe and services.exe; 
"System" hash checking removed; rule creation mask is fixed for 'ask' rule in the "Network activity" 
table. 
Uninstaller changed to clean up Jetico Personal Firewall registry entries. 
 
3-August-2006 | v.2.0.0.5 Beta 
Uninstaller problem fixed. "File"->"Save as" function implemented. 
 
1-August-2006 
Initial Jetico Personal Firewall v.2 release 


